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1 1 08/11/2011 Update following remarks from CNES 
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2 2 16/08/2012 
Further information on SIRIUS ephemeris data files and extra expert 

settings added 
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   New reference: DBK-MU-LOG-0258-CNES  

1 0 13/01/2014 
DM 685 Default parameter values and document management by CNES 

taken into account 

 

2 0 28/02/2014 

Due to the change of contract, this version of the document follows 

reference document DBK-MU-LOG-0258-CNES version 01.00”.  
DM 686: nomenclature changed from “expert mode” to “scientific mode”.  

2 1 25/04/2014 

CNES remarks taken into account 

(CNES_relecture_MUscientifique_GMV_24032014): 
MM-3: $7.6.2.3, clarification regarding the box. 
MM-4: $7.5.1.1, clarification regarding the DAS file. 
DM-713: $7.6.1.1, $7.4.1 use of the “—userMaterials” option 
 

2 2 18/11/2014 

FA-727: Use of a UTF-8 compatible editor 

Additional information on the way to custom the JVM memory. Section 

7.10 (FEP-3 FEPS_DEBRISK_pk_man_fa_dd_mm_01_02.xls) 

Additional terms added in section 3 (project action) 

DM-752: Modification in the ergonomics of DEBRISK GUI 

 

2 3 09/12/2014 Corrections due to FEPS raised by CNES during PKPV 

2 4 24/02/2015 

Added a warning to indicate that all the exported files (Electra, Google 

Eart, CSV) are done using the UTF-8 encoding. 

 

Clarification of the use of the quantity attribute of a fragment for the 

computation of the thermal_mass and the casualty_area. 

 

2 5 13/04/2015 

Corrections taking into account CNES remarks raised after V02.07.01 

delivery (DBK-MU-LOG-0258-GMV_02_04-RemPO) 

 

FA-810: § 7.5.1.5, § 8.2.1.3, clarifications on the logic followed for defining 

the colours of “demise altitude” and “impact energy”.  
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2 6 07/05/2015 FA-830: § 6.3, § 7.1, correction of minimum Java Virtual Machine version. 

2 7 12/12/2015 

DM-827 : Prise en compte de la STB du logiciel DEBRISK ed3 rév9 et 

autres évolutions du logiciel DEBRISK 

Section 7.2 screenshot update to take into account the updates in the GUI. 

 

Section 7.4.1: Addition of the –f flag to generate DML files in batch mode. 
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Section 7.5.1, section 8.2.1.3 : Added the new “Global Casualty Area” 

widget. 
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2 8 15/04/2016 

DM-833: Modification of section 7.6.2 to explain the computation of 

dimensions. 

FA-872: Modification of section 8.2 to describe the modifications in the 

csv header. 

DM-846 : Modification of section 5 to remove some resources that are not 

needed anymore. 

Creation of section 7.5.1.5 Result Panel to detail the contents of the result 

panel after the execution. 
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2 9 27/04/2017 

DM-891: Modification of section 7.4.1 to include the new expert 

parameters to define the satellite ablation, ballast parameters and objet file 

creation. 

Modification of section 7.5.1.3 to include the satellite mass decomposition 

in the information area. 

Modification of section 7.5.1.3 to include the aerodynamic mass field in 

the satellite definition dialog and its definition. 

Modification of section 7.5.1.3 to include the new functionality of 

accepting the dimensions of an object even if they are incoherent. 

DM-933: Modification of section 7.5.1.3 to describe the new algorithm of 

dimension input and to indicate the possible differences in two similar 

objects defined using different methods. 

Modification of section 7.5.1.3 and 7.6.2 to indicate the rounding of 

dimensions with too many significant digits. 

Modification of section 7.6.2.5 to include the new table with the significant 

digits per dimension. 

2 10 07/07/2017 

Implementation of CNES document corrections after review of version 2.9. 

 

FA-991 update of error messages related to the definition of the fragments. 

Section 9.4.2 

2 11 08/12/2017 

Modified the section 7.5.1.3 to include the information about the ballast 

mass and the aerodynamic mass of the satellite. 

Added section 7.5.1.4 to describe the new simulation parameters tab. 

Updated images to show the new simulation parameters section. 

 

2 12 05/12/2018 

Modification of section 7.5.1.3: addition of statement that the initial 

aerodynamic mass contains the mass of the solar panels. Change of 

screenshot to display the updated ones (with according correction of label 

for total mass with solar panels). Update of the screenshot of the right 

numerical values displayed in the edition of the spacecraft.  

Name of the frame displayed in IHM: modification of section 7.5.1.2, 

modification of the overall screenshots. 

Modification of section 8.2: addition of quantity, initial Ccond, final Ccond 

parameters in CSV file. Update list of parameters in TecPlot. 

 

Modification of sections 6.3, 7.5.1.2, 7.10: hyperlinks added. 

Modification of section 8.2: addition of quantity parameter in CSV file. 
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2 13 15/02/2019 

Modification of section 5 to include the complex shapes and the 

interpolator files (DM-1046). 

Modification of section 6.2 to include the new versions of Windows. 

Modification of section 7.5.1.3 to include de new complex shapes 

geometric parameters (DM-1048). 

Modification of section 7.5.1.4 to include the information about the 

parameter’s visibility depending of the other parameters value, and update 

of the parameters panels to include the new parameters (DM-1046). 

Added section 7.6.2.5 and 7.6.2.6 to include the definition of the complex 

shapes and their constraints (DM-1046). 

Modification of section 7.15 to include the errors related to the complex 

shapes (DM-1046). 

Modification of section 8.2 to include the information about the 

modifications of the output files (DM-1046, DM-1056, DM-1069). 

2 14 29/11/2019 

DM-1082: Modified section 7.5.1.7 to update the graphic plots. 

DM-1085: Modified the section 9.2 to modify the parameter 

ReferenceArea in ReferenceAeroAera and to add the new parameters 

ReferenceThermalArea and Qcond. 

DM-1098: Modified the sections 6.3 and 7.1 to indicate that Java 1.8 is the 

minimum version to use for the virtual machine. 

2 15 20/01/2021 

DM 1101 : Added section 7.7 “Heat flow” to explain that the absorbed 

radiation flux is null. 

 

Section 7.7 transformed into “Survivability parameter”. The section 

“Normal shutdown” becomes section 7.8 

 

DM-1427:  Figures 19 (Adding a root object window), 49 (Box tumbling) 

and 50 (Flat plate tumbling) updated so only the accurate rotation arrows 

are displayed. 

 

DM-1446 : Modified section 7.5.1.5 to add the fact that :  

- there is one Materials tab per simulation (so the Materials tab are 

independent),  

- there are some materials defined by default in the material tab, that are 

displayed in pur“le, named "”xx DEBRISK", and that cannot be modified, 

- there are two buttons in“this tab ("sav” mate“ials" and "loa” materials"). 

Screenshot fig36 changed to show the list of purple materials. 

Modified section 7.6.1.2 to add the default materials are displayed in 

pur“le, named "”xx DEBRISK" and cannot be modified. 
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Modified section 7.6.1.3 to add the fact that the existing“materials "”xx 

DEBRISK" can be duplicated, but the copy cannot be reg“stered as "”xx 

DEBRISK", and the oxidation properties are not be duplicated. 

 

DM-1462 : section 7.5.1.3 modified to add spheres as possible satellite 

shapes. 

 

DM-1463 : section 9.2 modified to add the fact that the name, creation 

date, version and mode are written at the beginning of the csv and Tecplot 

files. 

 

DM-1465 : section 7.4.1 modified to delete the ELECTRA file from the list 

of files that can be Generated. 

section 7.5.1.1 modified to remove any mention of the ELEcTRA file. 

section 8.5.4 modified to remove the ElectraFileException 

section 9.1 modified to remove the reference to the creation of an 

ELEcTRA file. 

section 9.2 modified to remove any reference to the ELEcTRA file. 

section 9.3.1 modified to remove any reference to the ELECTRA file. This 

section no longer is centered on the creation of an ELECTRA file, but on 

the creation of a simulation, and on the exportation of the result files. 

 

DM-1460 : section 7.6.2.5.2 modified to change the condition on h. 

 

Added section 7.8 to include the oxidation flow equations. 

2 16 26/11/2021 

DM-1474: Updated object images in section 7.7 “Shape of objects”. 
 
DM-1485: Addition of section 7.7.1.5 to describe the new hemispherical cylinder. 
 
DM-1559: Removed section 7.7.1.7 containing the significant digits for object 

dimensions. 

 

2 17 11/02/2022 

Modified section 7.6.1.1 to remove the paragraph about the default location of 
the userMaterials file that is not applicable to the LOS mode. 
 
Modified section 7.5.1.1 to update the description of the cross section area 
result and the associated screenshot. 
 
Modified section 7.5.1.6 to improve the description of the save action. 
 
Added section 9.5 with the 3D view configuration description. 
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2 18 02/11/2022 

 
DM-1626: Added section 7.5.1.5.1 to explain the loading of a material list in the 
IHM. 
 
DM-1627: Modified section 7.5.1.1 do add the new “Save As…” menu. 
 
DM-1646: Modified section 10.2 to add the new “azimuth” column to the 
Tecplot file definition. 
 
DM-1659: Modified section 10.2 to remove the “spacecraftMass” column from 
the Tecplot file definition. 
 

2 19 22/05/2023 

DM-1652: 
 Modification of the fragmentation validity range. 
 Update of screenshots to reflect the change of the IHM look & feel. 
 Modification of section 7.5.1.1 to include the Help menu description. 
 Modification of section 7.5.1.2 to remove the fragmentation altitude. 
 Modification of section 7.5.1.4 to include the update of simulation 
parameters section. 
 
DM-1670: 
 Modification of sections 7.5.1.2, 7.5.1.3 and 7.6.1.3 to include the 
information  
 about the warning message for incoherences in the input values. 
 
DM-1689: 
 Modification of section 7.4.1 to include the generation of the Cb/Mach 
file. 
  
DM-1692: 
 Modification of section 7.5.1.6 to include the definition of the weighted 
casualty area. 
  
DM-1693: 
 Addition of section 7.5.1.8 to describe the message area. 
  
DM-1695:  
 Modification of section 9.5.3 to indicate how to deactivate the 3D view 
manually. 
 
  
Global update of screenshots. 
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1 Introduction 

 

This document is a manual whose purpose is to give an exhaustive introduction to the functions 

available to the DEBRISK user performing simulations of the ablation of debris from a 

spacecraft after it has been destroyed upon re-entry into the atmosphere. 

  

DEBRISK has been created by RTECH under a development contract for CNES. It is now in 

maintenance phase by GMV, under contract for CNES. 
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2 Applicable and reference documents 

2.1 Applicable documents 

ID Document Reference Issue Date 

AD1 Technical Requirement Specifications DBK-CT-SPEC-009-CNES 5.4 TBD 

 

2.2 Reference documents 

ID Document Reference Issue Date 
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3 Terms, definitions and abbreviations 

 

Terms Definition 

Spacecraft 

A spacecraft is the parent object of all other user-defined objects. It 

comprises a (cylindrical, spherical or parallelepiped) main body, and 

one or more solar panels if it is needed. When re-entering the 

atmosphere at the end of its life, the spacecraft first loses its solar 

panels, and then splits into one or more fragments at a given altitude. 

Child 

A child is a fragment within another object. By definition, a fragment 

is a child, either of another fragment, or of the spacecraft. An object 

may have several children. Children are released into the atmosphere 

where the parent ceases to exist. 

Thermal mass 
The thermal mass is the mass of an object, not including the mass of 

its children, if any. 

Object 
An object may be a spacecraft or a fragment. 

Fragment 

A fragment is a part of the spacecraft, as defined by its shape, its 

dimensions and its material. A fragment only exists after 

fragmentation of the spacecraft. 

Aerodynamic 

mass 

The aerodynamic mass is the mass of an object, including the mass of 

all generations of children, if any. 

Downrange (IHM, 

.dat file) 

Length of the projection of object’s trajectory on the Earth’s surface 

(from the re-entry point of the space craft) 

Local downrange 

(dat file) 
Downrange computed from the moment the child is born. 

Downrange shortest 
Minimum distance between the initial point of the SC trajectory’s 

projection on the Earth’s surface and the impact point. 
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4 Conventions 

4.1 Symbols 

 

 

    A red triangle indicates an important remark. 

 

4.2 Stylistic conventions 

Stylistic conventions are used to highlight elements in the DEBRISK program. 

• Button « Button » “Button” references to software buttons are between quotation marks, 

French quotation marks or in italics.  

• Important words are underlined. 

• Command lines are written using the Courier font. 

4.3 Initial conditions of simulation models 

• An object is considered destroyed when its kinetic energy is below 14 J.  

• The object temperature at birth, i.e. the initial simulation temperature, is 300 K for all objects. 

• The atmosphere model used is the US 76 model. 

• A central force model is used as the gravity model. 
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4.4 Purpose of the software 

In 2008, the French Parliament voted the Space Operations Act (Loi sur les Opérations Spatiales, 

LOS), whose purpose is to set up a national system for authorisation and control of space operations 

under French jurisdiction. This law was followed by decrees and technical regulations which require 

that satellites should be subjected to a hazards study including an analysis of survivability on re-

entry. This analysis can be carried out for uncontrolled or controlled re-entry at end of life, and also 

for special launch failure conditions. 

CNES has been appointed by the State to certify the hazards studies. CNES must therefore acquire 

the means necessary for this certification. These means are put at the disposal of manufacturers and 

operators in the space sector bound by the LOS and are used for certification in all cases. 

The DEBRISK software is part of these means and has been developed by CNES since 2009. The 

development of the DEBRISK tool is due to the necessity for CNES to have independent and 

justified calculation models, and to put at the disposal of the engineers in charge of the risk 

calculations or of their verification a qualified tool based on validated models, whose source code 

is fully mastered by CNES. 
DEBRISK is intended to be the CNES tool used to conduct the analyses of the survivability of 

fragments originating in spacecraft on re-entry into the atmosphere. 

The DEBRISK software is a tool for analysis of the ablation of debris from a spacecraft after its 

destruction on re-entry into the atmosphere. It is based on an object-oriented approach, in which the 

space object is represented by a set of interconnected basic and complex geometries. A structure of 

the parent-child type is used to define the relations between these different objects. Each object is 

defined by its shape, its dimensions, its mass and its material.  

The user provides the initial kinematic conditions of the entry of the space object, and the software 

calculates the trajectory of the fragments and the possible ablation along this trajectory. The software 

gives a list of surviving objects and their characteristics on landing.  

DEBRISK allows the creation of one spacecraft at a time, but of as many child fragments as 

required. 

DEBRISK first calculates the trajectory and the kinematic conditions of the vehicle as a whole 

between the starting altitude specified by the user and the fragmentation altitude (between  100m 

and 200 km), considering a loss of solar power plant at 95 km. It then calculates the trajectory 

(between the fragmentation altitude and the ground) and the possible ablation of the fragments from 

the spacecraft. These fragments are defined by the user and can be matched as parent/child. Finally, 

DEBRISK calculates the casualty area of the surviving fragments. 
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To do this, the code solves the fundamental mechanics equation along the descent trajectory. 

Aerodynamic forces are estimated, for each flight domain, for each object. The heat fluxes 

encountered by the object for each flight domain are calculated, along with the increase in the 

temperature of the object. When the temperature of the object has reached the melt temperature, the 

object is ablated, and the changes in its dimensions and mass are taken into account when calculating 

the trajectory. The purpose of the DEBRISK tool is to calculate the surviving fragments of a 

spacecraft during its re-entry into the Earth’s atmosphere. It makes it possible to provide this list of 

fragments to the ELECTRA tool and to calculate the associated casualty area. 

The main functions of the DEBRISK software are: 

• the calculation of the aerodynamic coefficients of the object, 

• the calculation of the trajectory of an object in free fall towards the Earth,  

• the calculation of the aerothermodynamic fluxes,  

• the calculation of the temperature of the object, 

• the calculation of the ablation of the object. 
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5 External view of the software 

The following folders and files (between brackets) created by the DEBRISK installer are required for 

DEBRISK to operate: 

• 3DModels: Containing the 3D models used for GoogleEarth. 

• Database 

• Images: Containing the images used by the software- 

• Orekit-data: Containing the DE-406-ephemerides 

• XSD files for the verification of the XML file structure. 

• PDF files containing the user manuals. 
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6 Operational environment 

6.1 General 

The DEBRISK software requires the minimal software and hardware configuration described 

below. 

6.2 Hardware configuration 

It must be possible to execute the DEBRISK software on stations with: 

• A monitor with minimum resolution of 1280x1024. 

• A graphics card with minimum resolution of 1280x1024. 

• An amount of RAM of 2 gigabytes minimum (see note below).  

• 100 megabyte of disk space minimum. 

 

Note: After a simulation including dozens of objects, it is recommended not to move on to a 

2nd simulation without first closing the tab of the 1st simulation, so as not to take up too much 

memory, with consequences for the execution time. 

 

6.3 Software configuration 

The stations can be equipped with the following operating systems: 

• Windows 7, 8, 10  

• Linux REDHAT (Red Hat Enterprise Linux Desktop) 

• Linux SUSE (OpenSUSE) 

The operation of DEBRISK requires the installation of a JAVA virtual machine version 1.8 

minimum.  

The DEBRISK outputs are compatible with: 
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• Tecplot version 8 and later,  

• Microsoft Excel 97 and later, 

• Google Earth 5.0 and later, 

• ELECTRA V4.3 and later. 

In addition, Debrisk requires a recent PDF reader (e.g. Adobe Reader available on 

http://get.adobe.com/fr/reader/) in order to read this manual when using the DEBRISK “help” 

function (accessible by pressing “F1”). 

Please, note that the exported files by DEBRISK will be encoded following the UTF-8 format. See 

10.3 for more information on this topic 

http://get.adobe.com/fr/reader/
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7 Operating Manual 

7.1 Configuration and initialisation 

The DEBRISK installer comes in the form of a wizard proposing a limited and intuitive number of 

options.  

The installer specifies whether the Java version installed is incompatible (1.8 minimum). 

However, if Java is not installed at all, the installer does not start. Moreover, if the version 

installed is too old, the following message is displayed (found on JAVA version 1.4): 

 

 

In this case, install Java version 1.8 and restart the installer. 

7.2 Installation of DEBRISK 

The installation is carried out by opening the autoexec installation archive. An installation wizard 

is opened and proposes to modify the default installation directory. DEBRISK will then be created 

at the location specified by the user, with an executable “.jar” file inside and all the files necessary 

to launch DEBRISK.  

All these files must remain in this installation directory, as they are used by the software to 

perform the simulations. 

The default directory for the input/output files is the 

“<installation_directory>/DEBRISK/Database” directory. 

 



 

 

CNES 
 

DEBRISK 

 
Ref. DBK-MU-LOG-0268-GMV 

Date 22/05/2023 

Version 2.19 Page:  27/114 

 

 GMV  
17, rue Hermès 

Parc Technologique du Canal 
31520 Ramonville-St-Agne 

 

 

Figure 1 Opening the wizard. 

    

Figure 2 Selecting the installation directory. 
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Figure 3 Installation in progress 

 

You can choose to create a shortcut on the desktop: 

 

Figure 4 Selecting a shortcut if required. 

The “Default” button is used to reset the default value of the group of shortcuts (i.e. “Debrisk”), if 

this had been modified by mistake. 
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Figure 5 End of the installation 

The “Generate an automatic installation script” button is used to generate a script to be used for an 

identical installation (useful in case of deployment in a “standard” environment). 

When clicking on this button, the installer proposes to save a file which can then be copied from 

station to station to reproduce the same installation. The installation can then be launched as 

follows in command line:  

« java -jar name_of_Debrisk_installer path_of_script ».  

The installation then takes place in silent mode with the same user settings as for the installation 

which generated this script. 

7.3 Uninstallation 

To uninstall DEBRISK, execute the “DEBRISK_INSTALL/Uninstaller/uninstaller.jar” file, where 

“DEBRISK_INSTALL” is the DEBRISK installation file. 

The following window is displayed: 
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Figure 6 Uninstallation window 

The “Force the deletion of …” option is used for the complete deletion of the Debrisk file 

(including the saved simulations and exports, the user material file or any other file which might 

be stored there). 

Clicking on the “Uninstall” button launches the uninstallation. Click on “Quit” to close the 

window. 

 

Figure 7 Uninstallation completed 

 

7.4 Mode selection and control 

The DEBRISK software can be used in different modes: 

• Standard mode: graphic interface (see chapter 7.5) 

• Console mode 

 

7.4.1  The console mode 

The Debrisk software can be launched using a command line. Execution takes place in batch.  
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The syntax of the command line is as follows: 

java -jar debrisk.jar --input xml_input_file_path --output  no_extension_output_files_generic_path 

[-params]   [--debug] 

 params is a combination of one or more value(s) among: 

-r : creation of a CSV report 

-t : creation of a TECPLOT file 

-k : creation of a KML file 

-x : creation of an XML file, if the Create Cb vs Mach file option is selected the “CbMach” 

CSV file will be generated with in the same location. 

 -f : creation of DML file (Flat XML) 

 

For example, the line below: 

 "java -jar debrisk.jar --input /home/xxx/Debrisk/Database/case001.xml --output 

/home/xxx/Debrisk/Output/test1 -rtkx" 

 reads and loads the /home/xxx/Debrisk/Database/case001.xml file and creates the following files: 

 /home/xxx/Debrisk/Output/test1.csv 

 /home/xxx/Debrisk/Output/test1.dat 

/home/xxx/Debrisk/Output/test1.kml 

 /home/xxx/Debrisk/Output/test1.xml 

 /home/xxx/Debrisk/Output/CbMach_test1.xml 

 

 "-rtkx" here is equivalent to "-r -t -k -x" 

The extra “--debug” optional parameter is used to display more information in the logs (see §7.4.2). 
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The extra “--installDir <DIR>” optional parameter is used to specify the installation directory 

(<DIR> must here be replaced by the full path of the installation directory selected). By default, it 

is in the same location as the executable program. 

The extra “--userMaterials <FILE>” optional parameter is used to specify the path of the material 

file (<FILE> must here be replaced by the path of the material file selected) to be used instead of 

the materials properties defined in the configuration file. 

The "--help" command displays the notice of the command line syntaxes mentioned above. 

7.4.2 The IHM mode 

Apart from the desktop icon, the Debrisk software can be launched in IHM mode using a command 

line from the installation directory. The syntax of the command line is as follows: 

java -jar debrisk.jar [--installDir <DIR>] [--userMaterials <FILE>] [--debug] 

The “--installDir <DIR>” is an optional parameter used to specify the installation directory (<DIR> 

must here be replaced by the full path of the installation directory selected). By default, it is in the 

same location as the executable program. 

The “--userMaterials <FILE>” is an optional parameter used to specify the path of the material file 

(<FILE> must here be replaced by the path of the material file selected) to be used instead of the 

materials properties defined in the configuration file. 

 The “--debug” is an optional parameter used to display more information in the logs (see §7.4.3). 

7.4.3 Log management 

All error messages sent by the application to the user (exception, confirmation, warning, 

information, etc.) are archived in the form of logs in a “Debrisk.log” file in text format located in 

the DEBRISK execution directory. 

In addition to the normal “user” display, logs of the “DEBUG” type are recorded to save the 

information generated during the calculation (important variable values, location of the process in 

progress in the code, etc.). To display these extra logs, the “–debug” parameter must be specified 

when launching the application (see §7.4.1). 
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7.5 Normal operation 

7.5.1  Graphic interface 

In this section, you will learn how to use DEBRISK. When opening the software, the home page 

should be similar to what you can see below. 

 

Figure 8 Home page 

At this stage, it is possible to distinguish between the two main parts of the software, namely: 

• the message area on the top, 

• the scenario on the left, 

• the view of the results on the right. 

There is also a main menu accessible in the top left-hand corner. 
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7.5.1.1 Menu 

 

Figure 9 Menu 
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The following functions can be accessed from the File menu: 

“New”: creates a new tab in which you can create or open a new case to be studied. 

“Open”: is used to open a previously saved study case. 

“Export”: is used to export files to other software packages (Tecplot, Google Earth, CSV). 
 

The Tecplot, Google Earth and CSV files will be encoded following the UTF-8 format. 

Hence, in order to be able to read it properly, you must use a text editor compatible with 

UTF-8 (such as notepad++, for instance). 

If we want to import the file in Excel or any other program, you must indicate during this 

process that the file is encoded in UTF-8 format. 

“Save”: is used to save the case being studied by including the list of objects, the initial 

conditions, the simulation parameters, and the material properties. The case will be saved to the 

location from where it was loaded or saved last. In the case of new cases this menu is disabled 

until the case is saved for the first time. 

“Save As…” equivalent to the menu “Save” but ask systematically for the file location to save. 

“Quit”: is used to close the software. 

The following functions can be accessed from the File menu: 

“Show Help: Opens the Debrisk user manual. 

“Show Handbook/Methodology”: Opens the Debrisk methodology guide. 

“About”: Shows the dialog containing the program information. 

 

Figure 10: About dialog. 
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7.5.1.2 Scenario area 

Entry conditions: 

 

Figure 11 Scenario area 

You will find various tabs in this area. The first one, named “Entry conditions”, must be filled in 

with the general parameters of the initial point corresponding to the kinematic conditions of the 

spacecraft to be studied. The parameters to be entered are the parameters of the Keplerian orbit of 

the object: 

• The date and time in format YYYY-MM-DD and HH:MM:SS 

• Selection of the entry parameters (Apogee/Perigee or semi-major axis/Eccentricity) 

• Semi-major axis in km (according to the selection made above) 

• Eccentricity (according to the selection made above) 

• apogee altitude in km (according to the selection made above) 

• perigee altitude in km (according to the selection made above) 

• perigee argument in degrees 
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• inclination angle in degrees 

• right ascension of ascending node in degrees 

• anomaly (true, mean or eccentric) in degrees. 

Remark: the frame in which the initial orbit is defined is displayed next to the label “position”. 

It should be noted that when the semi-major axis and the eccentricity are entered, DEBRISK 

automatically calculates the apogee and perigee altitudes and vice-versa. It is therefore 

necessary to enter only one of these two sets. The Earth equatorial radius is given for information 

and is only used for this reverse calculation (apogee and perigee to semi-major axis and 

eccentricity). 

 

The date entered is limited by the ephemeris data files available in the orekit-data/DE-

406-ephemerides/ folder in the DEBRISK installation folder. Each file contains data 

for 300 years from the date mentioned in the file name (e.g. unxp1800.406 contains 

the data for the years 1800 to 2100). DEBRISK is therefore installed with the data 

for the years 1800 to 3000. If the date entered is outside this bracket, a message informs the 

user that simulation is not possible, and prompts him to download the data files containing the 

years for which he wants to conduct a simulation. These files are available on 

ftp://ssd.jpl.nasa.gov/pub/eph/planets/SunOS/de406/. 

The values of the entry conditions will be verified for coherence, if the values are not coherent a 

message containing the incoherences is displayed at the bottom of the panel: 

ftp://ssd.jpl.nasa.gov/pub/eph/planets/SunOS/de406/
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Figure 12 message containing the incoherences. 
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Figure 13 Orbit definition 

 
FR EN 

Argument du périgée Argument of perigee 
Point vernal Vernal point 

Longitude du nœud ascendant Right Ascension of ascending node 

Inclinaison Inclination 

The entry conditions can be computed from a TLE, using the Import TLE button. 
 

 

Figure 14: TLE Import button 

When clicking in the Import TLE button a dialog will open to allow to insert the two lines 

elements of the corresponding orbit, the entry conditions will automatically be computed from this 

TLE. 

 

Figure 15: Import TLE dialog 

 The tle lines inserted in the Import TLE dialog shall respect the format of the two lines 

elements as described in https://celestrak.com/columns/v04n03/ 

In the lower part of the scenario area are three buttons: “Reset”, “Run” and “Cancel”. When all the 

objects have been created or imported, you can use the “Run” button to launch the simulation. You 

will then see the two progress bars move to 100%. The first progress bar shows the overall progress 

of the simulation, including all objects. The second progress bar shows the stage reached by the object 

currently being simulated. 

The “Cancel” button can stop the simulation in progress. 

https://celestrak.com/columns/v04n03/
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Once the simulation has been completed, you must click on the “Reset” button before launching a 

new simulation or if input object data is to be modified. The “Reset” button resets the parameters to 

their initial value. The activation of these three buttons works according to the following logic: 

- “Cancel” button is only active when the computation is running. 

- “Reset” button is only active when results have been computed (and “Run” is not active). 

- “Run” button is only active if we are: 

o Not computing 

o Results are not available (we have done “Reset” after having run) 

o The object table is not empty. 

o There are no errors in the object table. 

o We are not editing any object in the table (directly, if we are using a dialogue as it is 

modal, buttons state is not updated). 

7.5.1.3  Objects tab 

The object tab allows you to add new objects using the Add button, to edit some objects already 

created using the Edit button, to duplicate objects using the Duplicate button, to delete them using 

the Delete button and to change from input to output display –and vice versa- after having run a 

configuration using the Swap button.  

When clicking on “Duplicate”, the whole group of children, grandchildren,… of the selected object 

will also be duplicated. 

The activation of these buttons works according to the following logic: 

- “Add” button follows the same logic than the “Run” button. 

- “Delete” button is active whenever the “Run” button is enabled and at least one row is selected 

in the object table. 

- “Duplicate”/”Edit” buttons are active when the “Run” button is enabled and if one row is 

selected in the object table. 

- “Swap” button is only active when results of a computation are available i.e. whenever the 

“Reset” button is enabled 

In the left part, you can see a tree representing the overall structure of the case you are about to 

simulate. The indentation of the elements in this tree shows the parent-child links existing between 

the different objects. This tree offers the user the possibility to drag and drop any object into another 

one: the latter will automatically become the parent of the selected object and the table will be 

properly updated with the new information. From a practical point of view, the user is not allowed 

to move an object downwards along the same branch since it does not add any physical meaning to 

the problem. 
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Figure 16 Object tab 

Below the objects table, before the simulation, the satellite mass decomposition is displayed: 

• mass_a: aerodynamic mass of the satellite (kg) 

• mass_b: ballast mass (kg) 

• mass_c: mass of the satellite children (kg) 

• mass_th: thermal mass of the satellite (kg) 

• gs_num: number of solar generators. 

• gs_mass: total mass of the solar generators. 

• gs_surface: total surface of the solar generators. 

 

 

Figure 17: Total casualty area after a simulation reset. 

 

If the ballast mass is negative, it will be displayed in red. 
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Figure 18: Negative ballast mass. 

After the simulation, the total casualty area (corresponding to the addition of the casualty area of 

all the fragments) ) and the total weighted casualty area will be displayed below the objects table: 

 

Figure 19: Total casualty area value after an execution. 

 

 If a configuration file without satellite aerodynamic mass (i.e. from a previous version) is 

opened, the satellite aerodynamic mass is computed by adding the satellite thermal mass and the mass of 

solar panels. This case will generally lead to a negative ballast mass. 
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Creation of objects 

Please note that the first object in the list is always a spacecraft, while the others are always 

fragments. The spacecraft can only be modelled by a box, a cylinder or a sphere, and solar panels 

can be added. 

To add an object, select a parent object in the tree or the table and click on the Add button. A new 

window is displayed: 

 

Figure 20 Adding a root object window. 

 

Figure 21 Adding an object window. 
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In this window, you are asked to enter the following elements: 

• Parent: contains the name of the object parent of the one being created (for the spacecraft 

this field is not displayed). 

• Name: allowing to insert the name of the object. 

The name of the object cannot contain the character “#”, using this character makes 

the object invalid. 

 

• Relationship: menu to indicate if we are creating a “component” or a standard “child”, for 

more details see “creation of components” paragraph below. 

• Object’s quantity: this parameter is used when the operator wants to define several fragments 

with the exact same characteristics. Even if Q>1, a single simulation will be run for the 

fragment. 

This value will only be used to compute the aerodynamic mass of an object having children 

with Q/=1 and for the casualty area (which will be computed as the casualty area of the 

simulated fragment multiplied by Q). 

• Shape: selection of the shape of the object. 

• Specification: selection of the mode to enter the dimensions of the object according to the 

data at your disposal. All the other data will be calculated by DEBRISK so that they 

correspond to the data provided by the user. 

• Material: the material of the object to be selected in the list. 

• Dimensions to be complemented according to the mode selected beforehand. If mass is 

one of the required dimensions, the thermal mass of the object is expected. The other 

dimensions are derived from the first ones and all the dimensions are displayed in the table 

on the right of the “Object properties” window. 

• For the satellite only, the aerodynamic mass corresponding to: 

aerodynamic_mass = thermal_mass + ballast_mass + children_mass + 

solar_generators_mass 

The ballast_mass is then calculated automatically by DEBRISK as: 
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ballast_mass = aerodynamic_mass – (therma_mass + children_mass + 

solar_generators_mass) 

 

The ballast_mass is displayed below the object table. 

For other objects, the aerodynamic mass is not displayed but is computed by Debrisk taking 

into account the quantity of unborn children of the fragment to be simulated. This value is 

computed recursively: 

Aerodynamic_mass = thermal_mass_of fragment + ∑ (child_mass * child_quantity * 

(child_child_mass * child_child_quantity …)) 

• Conduction coefficient: This coefficient represents the thermal conductance between an 

object and its parent object. It only applies to objects which are in contact. It can be 

defined for any object except the root object (satellite). The definition of the conduction 

coefficient can be done following a Linear or a Polynomial model. 

In the Linear case, the first number in each pair is the temperature, and the second corresponds 

to the value of the conductance coefficient. In this mode, a straight line is drawn between each 

pair of values. 

 

Figure 22 : Linear model for conductance 

If you prefer to use the polynomial form, you must specify the degree of the polynomial and 

provide the coefficients. If you enter only one coefficient, this means that the parameter is 

constant over the whole temperature range. 
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Figure 23 : Polynomial model for conductance 

If no value is entered, the conductance coefficient value is the default value: 0. 

Solar panels can be added on the root object (satellite) using the “solar panels” button, which is 

only displayed on the window for this object. 

• Separation temperature 

The user can choose to specify a temperature beyond which the object will automatically be 

considered fully ablated. To do so, the user can check the “use separation temperature” box and 

specify the separation temperature. 

When an object has the "separation temperature" criterion activated, then all its children of type 

component who also have "separation temperature" criterion activated must have a higher 

separation temperature than their parent. Otherwise, they will be considered invalid and displayed 

in red. 
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You can then specify the number of solar panels, the mass and the unit surface of the panels. 

 

Figure 24 Adding solar panels 

Finally, click on Apply to create the object or on Cancel to cancel the creation. 

The values of the object will be verified for coherence, if the values are not coherent a message 

containing the incoherences is displayed at the bottom of the dialog and if the user applies a 

confirmation dialog will be displayed: 

 

Figure 25 Incoherence dimensions dialog 
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Figure 26: confirmation dialog 

 

In this case the user has the option to continue the edition of the object or accept the incoherence, 

in the latter case the object line will be displayed in red in the object table. 

 

Figure 27 Display of an incoherent object 

When you click on an object in the tree, the corresponding object in the table will be selected, and 

vice versa. 

 

Creation of components 

 

A component is a type of object that has the following characteristics: 

• A component cannot have children. 

•  The mass of a component is not taken into account in the aerodynamic mass of the parent. 

•  A component does not participate to the conduction heat fluxes. 

•  The spacecraft cannot be a component. 

• When the parent disappears, the component will only be born if the parent’s disappearance 

is due to the fact that it reached its separation temperature. Otherwise (in case of ablation, 

for instance), the component will not be born.  

• When a component is born, its temperature equals its parent’s separation temperature. 

 

A component can be created by selecting “component” in the “Relationship” menu in the object 

properties window.  
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Figure 28: Relationship menu 

 

When created, a component appears in blue in the objects tree on the left side of the objects table 

if a separation temperature has been defined for its parent. Otherwise, it is displayed in grey and 

will never be born. 

 

If a component has descendants, they can only be of component type, otherwise the component 

will be displayed in red and considered invalid. 

 

The spacecraft object cannot be of component type, otherwise it will be displayed in red and 

considered invalid. 
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The objects table 

When you click on an object in the tree, the corresponding object in the table will be selected, and 

vice versa. 

In the table you will find the following information: 

• Name: object name, only used to track objects during data post-processing. 

• Quantity of fragments: This parameter is used when the operator wants to define several 

fragments with the exact same characteristics. Even if Q>1, a single simulation will be run 

for the fragment. This value will only be used to compute the aerodynamic mass of an 

object having children with Q/=1 and for the casualty area (which will be computed as the 

casualty area of the simulated fragment multiplied by Q) 

• Shape: shows the geometry selected to represent this object. This can be a sphere, a box, a 

cylinder, etc. All the geometries and associated parameters are presented later in this 

manual. 

• Material: shows the material used for the object 

• Mass_th: shows the mass of the object itself, without taking the mass of the children into 

account. This mass therefore corresponds to the thermal mass in the software, as it is the 

mass used in thermal equations. 

• Rout/Height, Rin/Width/Rs Length/Rl and Thickness, Angle, Flatness: dimensions of the 

object. The dimension presented in the column depends on the type of object considered. If 

you run the mouse over the column header, you can view the dimension presented 

according to the shape. The Angle and Flatness columns apply only to complex shapes, for 

simple shapes they will be greyed out. 

• CCond: Conduction coefficient that will be applied to the computation of the conduction 

flux. 

In this table, double-clicking on one of the cells allows you to edit the corresponding data of the 

object, unless you double-click on the “name” column, in which case you can only edit the object 

name. Note that Shape cells cannot be edited in the objects tab. 

Only the dimensions of the object corresponding to their definition method will be editable. The 

other dimensions are derived from the first ones are read only and displayed in italics. 

The Angle and Flatness columns apply only to complex shapes, for simple shapes they will be 

greyed out. 
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For example, if a sphere is specified using inner and outer radius, the mass and thickness cells will 

be read only and displayed in italics. 

 

Figure 29 Display of read only dimensions 

If you run your mouse above a line in the table, you will see information on the object as in Figure 

30. This information includes in particular the physical parameters used to create the object. If one 

of the values is in red, this means that the value of this parameter is not consistent with the other 

chosen values. 

 

Figure 30 Information table 
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Edition of objects 

If you click on the “Edit” button, a new window will display as in Figure 31. 

  

Figure 31 Object edit interface. 

This window is identical to the one used to create an object. In this particular case, it is pre-filled 

with the data for the object selected. You will find in it the parameters visible in the previous table. 

In the upper part of the window (Figure 31) you can see an image representing the shape of the 

object selected and its attitude. In the right part, you will find a table summarising the parameters 

used for the creation of the object. If one of the parameters is not consistent with the others, it will 

be in red. 

You must click on the “Apply” button for the changes made to be taken into account. 

The user can also change the values of the characteristics of each object directly by double-click 

on the cell of the object table to be modified. Once the operator clicks outside the selected cell, the 

validity checks are triggered and if the definition of the object is no longer coherent, it is displayed 

in red (and the “Run” button is disabled), as shown below: 
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Figure 32 Editing an object directly in the table 

 

 

Figure 33  Wrong value while editing an object directly in the table 
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During the configuration loading, the program might modify automatically the characteristics of 

an object by rounding some values to remove some extra significant digits. A dialog window is 

opened to inform the user of the modification and the object line will be marked in blue. 

 

Figure 34: Dialog to inform the user about the automatic modification of the object properties. 

The automatically modified object will be kept in blue, until the configuration is saved or until 

another property of the object is modified, in this case we consider that the automatically modified 

value has been assessed. 

 

Figure 35: Automatically modified object in input panel. 

  

Figure 36: Automatically modified object in result panel. 
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7.5.1.4 Simulation Parameters tab 

In the Simulation Parameters tab, you will find the options to select: 

• The fragmentation method for the satellite. 

• The atmosphere model. 

• The options for the creation of the Cb/Mach files. 

 

Figure 37: Simulations Parameters tab 

The visibility of some of the input fields depend on the value of other fields: 

• When “Atmosphere model” is “MSIS2000” the solar and magnetic activity fields are 

displayed. 
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7.5.1.5 Materials tab 

Each simulation has its own Materials tab, so the modification of the properties of a material of 

one simulation does not impact the corresponding material of another simulation. 

In the Materials tab, you will find the properties of the various materials used in the simulation. 

This includes the following parameters for each material: 

• density in kg/m3 

• heat of fusion in J/kg 

• melting temperature in K 

• oxidation heat in J/kg (O2) 

There is also a graph summarising the thermal properties of the material, in which you will find a 

line corresponding to the emissivity and Cp according to the temperature. 

Some materials are defined by default. They are displayed in purple and named “xxx DEBRISK”. 

They cannot be modified. As for the other types of materials, the user can change the values of 

their characteristics of each material directly by double-click on the cell of the table to be 

modified. 

I f one of the materials is not recognized by the software when opening of an XML 

file, DEBRISK ask the user if the materials shall be created with all their properties 

set to null or if the objects shall be associated with the “Unknown” material, whose 

properties are visible but cannot be changed in the material table. 

The list of all the unknown materials is displayed in a single pop-up to warn the user: 

 

Figure 38 Unknown materials warning pop-up 
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The creation of these materials by the user is explained in section 7.6.1.3. 

The panel contains 2 buttons: 

• Load materials: To load a userMaterials file into the panels. The parameters not contained 

in the file will be loaded with their default values. If the values of the parameters of default 

materials are different from the default ones, an error message will appear. 

• Save simulation parameters: To save the current materials panel contents into an xml file. 

 

Figure 39 Materials tab Panel 

 
 

 

 

 

 

Figure 40 Materials tab thermal properties graph 
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7.5.1.5.1 Loading of a material list 

The user can load a material list using the “Load Materials” button and selecting a material list xml 

file. A confirmation window will be displayed: 

 

Figure 41 Load materials confirmation dialog 

If the user cancels the current material list will remain unmodified, in other case the new material 

list will be loaded. The properties of objects related to material properties as the mass and volume 

will be modified accordingly. 

If the new material list does not contain all the materials used by the objects in the simulation, the 

missing materials will be added to the list. A dialog will be displayed allowing the user to select to 

add these materials with all their properties set to null or not to add them and use the Unknown 

material instead: 

 

Figure 42: Selection of missing material properties 

 

7.5.1.6 Result Panel 

After a simulation, in the object tab, a table displays a summary of the state of each object at the 

end of the simulation. 
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Figure 43 Results table 

We then find: 

• Name: Containing the object name. 

• Q: Containing the quantity of fragments. This parameter is used when the operator wants 

to define several fragments with the exact same characteristics. Even if Q>1, a single 

simulation will be run for the fragment. This value will only be used to compute the 

aerodynamic mass of an object having children with Q/=1 and for the casualty area (which 

will be computed as the casualty area of the simulated fragment multiplied by Q). 

• Demise altitude: The object destruction altitude, the cell is coloured in red if the object is 

not destroyed and in green if it does not reach the ground. 

• Impact Energy: The energy of the fragment on impact, the cell is coloured in red if the energy 

on impact is higher than 14J (or value of maximum energy on impact specified in the expert 

settings file), in yellow if it is lower or equal, or in green if the object does not reach the 

ground. 

• ∑ Casualty Area: The casualty area in the case of an object which reaches the ground. 

• ∑ Weighted CA: The weighted casualty area in the case of an object which reaches the 

ground. 

• Cross section area: Average surface. 
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• End mass_a: Final aerodynamic mass of the fragment, in case the fragment is destroyed 

before reaching the ground, otherwise it will be 0.0. 

• Ini mass_a: Initial aerodynamic mass of the fragment. 

• %Mass_a left: Percentage ratio between End mass_a and Ini mass_a. 

• Max_T: Maximum temperature reached by the fragment. 

• End_T: Final temperature of the fragment when it is destroyed or reaches the ground. 

• End_CCond: Final value of the conductance coefficient when the object is destroyed or 

reaches the ground. 

Below the table, the total casualty area is displayed: 

Total Casualty Area = casualty_area_fragment * quantity * parent_quantity * 

parent_parent_quantity…. 

Total Weighted Casualty Area = weight_factor * total_casualty_area 

With weight_factor computed as: 

0     𝑖𝑓        Energy < min 𝑊𝐶𝐴 

0.5 − 0.5 cos (
ln(𝐸𝑛𝑒𝑟𝑔𝑦) − ln (min 𝑊𝐶𝐴)

ln(max 𝑊𝐶𝐴) − ln (min 𝑊𝐶𝐴)
)     𝑖𝑓     min 𝑊𝐶𝐴 ≤  𝐸𝑛𝑒𝑟𝑔𝑦 ≤ max 𝑊𝐶𝐴 

1     𝑖𝑓        Energ > max 𝑊𝐶𝐴 

With “min WCA” and “max WCA” the values of the fields “Minimum/Maximum impact energy 

for weighted casualty area” defined in the “Models section” of the “Simulation Parameters” tab. 
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7.5.1.7  Viewing area 

The viewing area is in the right part of the interface. It is used to analyse the evolutions of the 

various parameters during the simulation. The results are presented in five types of predefined 

graphs that can be selected via a combo-box: 

• altitude vs. time 

• thermal mass vs. time 

• thermal mass vs. altitude 

• altitude vs. downrange 

• temperature vs. time 

 

Figure 44 Viewing area on the right 

The user is also able to add/delete any other custom graphics to plot one of the available parameters 

against any other one. To add a new plot, once the button “add” is clicked, a new window appears 

where the user can choose the parameters to be plotted. 
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Figure 45 Creation of custom plot 

To delete any custom graphic, one must only click on the “Delete” button after having selected the 

plot to be removed (please note that the five plots defined by default cannot be removed). 

The user can additionally change the order of the axis of the selected plot by clicking on the 

“Invert” button: 

 

Figure 46 Invert plot 
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When there are too many objects in the simulation, it can be interesting to only view some of them 

in order to make the analysis easier. To do this, you must select these objects in the table on the 

left, right-click on one of the objects and click on “Plot selected objects”. Only the objects that 

have been selected in the table are displayed in the graphic. 

To make multiple selections, you can use the “CTRL” and “SHIFT” buttons on your keyboard. 

The selected lines will be coloured in blue.   
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Google-Earth view 

Here-below is an example of simulation viewed in Google Earth.  

To be able to view the results in Google Earth, you must save the simulation by clicking on the 

“Export” button, and then “KML”, select the backup directory, the file name, and click on “save”. 

Finally, open Google Earth and open the file you just saved. In the top left-hand part, you can 

click on the second button to see the trajectory move. 

You will then see that when an object is destroyed or reaches the ground, the 3D model of the 

object turns into a small yellow thumbtack. You can click on it to obtain more information on the 

end-of-flight of this object, as you can see on Figure 47. 

The simulation made can also be saved by clicking on File and then on Save, and by selecting a 

backup name. This will save the list of objects, as well as the parameters of the scenario, making it 

possible to re-launch an identical simulation at a later stage. 

 

 

Figure 47 Simulation viewed in Google Earth 
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7.5.1.8 Message zone 

The top area of the IHM contains a message zone where all the messages produced during the execution are 
displayed. 

The contents of the message zone can be cleared using the “Clear” button. 

The message zone will not be cleared when resetting the simulation or executing it again. 

Each simulation has an independent message zone. 

 

Figure 48: Message area 
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7.6  Materials 

7.6.1.1 Materials file 

An alternative location of the materials file can be specified by the user using the command line 

option: 

--userMaterials <materials file path> 

The option works both in batch mode and in MMI mode. 

7.6.1.2  Integrated materials 

A certain number of materials are created during the installation of Debrisk. You can choose among 

these materials every time you want to create or edit an object. A drop-down list containing all the 

materials is available. 

Some materials are defined by default. They are displayed in purple, are named “xxx DEBRISK” 

and cannot be modified or removed. 

7.6.1.3  Materials created by the user 

If you wish to use a specific material not available as yet in DEBRISK, you can create it. To do so, 

you must click in the “Material” tab in the “Scenario” part, and then on the Add button. 

When you wish to create a new material, you have two possibilities. Either you create it from scratch 

(by clicking directly on Add), or you derive it from an existing material by selecting a material and 

clicking on Duplicate. Either way, it is not possible to name the new material with a character string 

containing “Debrisk”.  When duplicating a “xxx DEBRISK” material, the oxidation properties are 

not duplicated, they are set to their default values. 

The userMaterials file will not be automatically saved each time the property of a material is 

changed. The user can save the materials by using the “save materials” button. To create a totally 

new material, you must enter the following parameters: 

• Name: material name 

• Density: density of the material (in kg/m3) 

• Melting Temperature: melting temperature (K) 

• Heat Of Fusion: heat of fusion (J/kg) 

• Oxide Heat Of Formation: oxidation flux (J/kg (O2)) 

• Emissivity: emissivity 
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• Heat Capacity: heat capacity (J/kg/°K), 

For the first five parameters, you must enter a single value, which will be a character string for the 

name of the material, and numeric values for the density, the melting temperature, the heat of fusion 

and the oxide heat of formation. The name of the material created cannot contain the character string 

“debrisk”. 

If the material definition is invalid because some parameters are out of range an warning method 

will be displayed at the bottom of the window and if the user wants to apply the values a 

confirmation will be requested. 

For the emissivity and the heat capacity, you can enter either a table of values according to the 

temperature or a polynomial (or a constant) representing this relationship. 

 

Figure 49 Adding a customised material. 

 

Figure 50: Confirmation dialog for invalid materials. 
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If you wish to enter a table of values, select the “linear Interpolation” type in the window which opens (see 

Figure 51). The first number in each pair is the temperature, and the second corresponds to the value of the 

parameter you wish to define, i.e. in our example, the emissivity. In this mode, a straight line is drawn 

between each pair of value. 

 

Figure 51 Entry of a linear evaluation 

If you prefer to use the polynomial form, you must specify the degree of the polynomial and provide 

the coefficients. If you enter only one coefficient, this means that the parameter is constant over the 

whole temperature range. In the example given above (see Figure 52), k is considered as constant 

and equal to 110, regardless of the temperature. 

 

Figure 52 Entry of a polynomial 

In both cases the emissivity and Cp will be evaluated in the temperature range (300K to melting 

temperature) in steps of 10 degrees to verify that both properties are positive (>= 0.0) in all the 

range. 
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If this is not the case, an error message will be displayed and it will not be possible to apply the 

changes to the material until the problem is corrected. 

7.7 Shape of objects 

The objects available in DEBRISK are described in this section. The objects are defined by their 

geometrical shape. The attitude of the object depends on its aerodynamic behaviour, on the forces 

applied on separation, on the position of the centre of gravity of the object, factors which are difficult 

to predict accurately. The use of external tools could be envisaged to guide the user in the choice to 

be made for each object. In the current version, all the objects are considered to be in tumbling 

attitude mode during their re-entry. The tumbling attitude of each object is defined by its shape and 

defined below in the corresponding section. 

To choose the shape of the object, you must click and fill in the shape field in the “object properties” 

window. 

Depending on the shape, you can select the set of dimensions to fill out. With these values the 

software will compute the rest of the dimensions. 

The precision for the dimensions used to define a shape is 14 significant digits, the rest of the 

dimensions will be computed with the machine precision. 

The same object defined using different sets of dimensions will produce two similar 

objects but not identical, so the results of the simulation may differ. 

 

 

  

Figure 53 Spheres defined using different methods, obtaining different results 
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7.7.1.1  Sphere 

There is only one type of sphere, which is assumed to be in random tumbling mode around the 

three axes presented in the figure below. 

 

Figure 54 Hollow sphere random tumbling. 
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Figure 55 Solid sphere random tumbling. 

To create a spherical object, you can enter one of the following sets of parameters according to the 

selection made in the “specifications” field. 

- For the hollow sphere: 

• outer radius and inner radius 

• outer radius and mass 

• outer radius and thickness 

- For the solid sphere: 

• mass 

• outer radius 

The other parameters required for the calculation and not given by the user will be computed by 

the software. For example, if you choose to enter the outer and inner radii, the software will 

calculate the corresponding thickness and the mass according to the material selected. 
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7.7.1.2 Cylinder 

The cylinder is considered to be in random tumbling mode as defined in Figure 56. 

 

Figure 56 Hollow cylinder random tumbling 
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Figure 57 Solid cylinder random tumbling 

 

To create a cylinder, it is necessary to provide one of the sets of information bellow: 

- Hollow cylinder: 

• outer radius, inner radius and length 

• outer radius, thickness and length 

• outer radius, length and mass 

- Solid cylinder: 

• outer radius and mass 

The other parameters required for the calculation are deduced by the software. 

 The length and inner and outer radii must be between 0 and 100m. 
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7.7.1.3  Box 

The box is defined by the user by entering one of two following series of parameters: 

• length, width, height, thickness 

• length, width, height, mass 

For a hollow box, both series can be used. For a solid box, use the < length, width, height, mass > 

series, having first calculated the mass by the volume x density. 

Note: the length must be greater than the width and the width must be greater than the height. 

 

Figure 58 Box tumbling 

The box is considered to be in random tumbling mode around its longest axis.  
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7.7.1.4  Flat plate 

The flat plate can be defined by the following parameters: 

• length, width, thickness 

• length, width, mass 

Note: as the box, the length must be greater than the width and the width must be greater than the 

thickness. 

 

Figure 59 Flat plate tumbling. 

As the box, the flat plate is considered to be in random tumbling mode around its longest axis. 

The thickness of the plate must be below 10% of the width. Otherwise, a box object must be used. 
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7.7.1.5 Hemispherical cylinder 

The hemispherical cylinder is considered to be in random tumbling mode as defined in Figure 60. 

 

Figure 60 Hollow hemispherical cylinder random tumbling 

To create a hemispherical cylinder, it is necessary to provide one of the sets of information bellow: 

- Hollow hemispherical cylinder: 

• outer radius, inner radius and length 

• outer radius, thickness and length 

• outer radius, length and mass 

The other parameters required for the calculation are computed by the software. 

 The length and inner and outer diameter must be between 0 and 100m. 
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7.7.1.6 Complex shape 

The complex shapes are divided in to categories depending on the value of the flatness parameter: 

• Conical 

• Spherical 

Complex shapes are defined by the following parameters: 

• large radius, small radius, height, thickness, angle 

• large radius, small radius, height, mass, angle 

 

The angle of aperture of complex shapes can be between 0 and 360 degrees, for the range of angle 

values between 359 and 360, the shape is considered closed and the value of 360 is used. 

 

 

When defining a complex conical shape, tube equations will be used if all the following 

conditions are satisfied: 

𝑹𝒍 = 𝑹𝒔 

𝒂𝒏𝒈𝒍𝒆 = 𝟑𝟔𝟎. 𝟎° 

𝟎. 𝟏 <
𝒆

𝑹𝒍
< 𝟏. 𝟎 
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7.7.1.6.1 Complex conical shape 

 

Figure 61 Complex conical shape tumbling. 

 

 

Figure 62 Complex conical shape profile. 

The apothem of the conical shape is computed as follows: 
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𝐴 =  √ℎ2 + (
𝐷𝐺 −  𝐷𝑃

2
)

2

 

The angle η is defined as follows: 

cos 𝜂 =
ℎ

𝐴
 

 

The following constraints shall be respected by the shape to be considered valid: 

 

𝑹𝒍 ≥ 𝑹𝒔 

𝑹𝒍 > 𝒆 𝒄𝒐𝒔 𝜼 

𝒉 > 𝟎 

𝟎 < 𝒆 ≤
𝑨

𝟏𝟎
 

 

When the following conditions are fulfilled: 

𝑹𝒍 == 𝑹𝒔 

𝟏. 𝟎 >
𝒆

𝑨
>  𝟎. 𝟏 

the conical shape is modelled as a tube. 

 

When  
𝒆

𝑨
≥  𝟏. 𝟎  

an error is raised indicating the user that a cylinder shall be used to model the shape. 
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7.7.1.6.2 Complex spherical shape 

 

Figure 63 Complex spherical shape tumbling. 
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Figure 64 Complex spherical shape profile. 

 

The apothem of the conical shape is computed as follows: 

𝐴 =  √ℎ2 + (
𝐷𝐺 −  𝐷𝑃

2
)

2

 

The following constraints shall be respected by the shape to be considered valid: 

𝑹𝒔 ≥ 𝟎 

𝑹𝒍 ≥ 𝑹𝒔 

𝒉 > 𝟎 

𝒉 ≤
𝟏

𝟐
√(𝑫𝒈)

𝟐
−  (𝑫𝑷)𝟐 

𝟎 < 𝒆 ≤
𝑨

𝟏𝟎
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7.8 Heat flow 

The absorbed radiation heat flow is assumed null at any altitude. 

7.9 Oxidation flows 

The heat and mass flow produced by the oxidation depends on the model used: 

OxyV3 

• 𝜗𝑂 : stoichiometric coefficient of the oxygen in the formed oxide 

• 𝜗𝑀 : stoichiometric coefficient of the metal alloy in the formed  

• 𝑀𝑂 : molar mass of the oxygen [kg mol-1] 

• 𝑀𝑀 : molar mass of the metal alloy formed in the oxide [kg mol-1] 

• 𝑥𝑀 : mass fraction of metal formed in the oxide  

• Δ𝑓𝐻0 : molar standard formation enthalpy (<0) [J mol-1] 

• 𝑀𝑀𝑂𝑥
 : molar mass of the oxide [kg mol-1] 

• 𝜌0 : mass density of the alloy oxide [kg m-3] 

• 𝑥0 : thickness of the oxide layer [m] 

 

�̇�𝑜𝑥 = −
1 +

𝜗𝑂

𝜗𝑀

𝑀𝑂

𝑀𝑀

1 + 𝑥𝑀
𝜗𝑂

𝜗𝑀

𝑀𝑂

𝑀𝑀

 
∆𝑓𝐻0

𝑀𝑀𝑂𝑥
𝑥𝑀 𝜌0 

𝑑𝑥0

𝑑𝑡
= 𝑘𝑜𝑥

𝑑𝑥0

𝑑𝑡
 

With 

 
𝑑𝑥0

𝑑𝑡
=

𝑘′(𝑇)

𝑥0
  For adherent materials 

𝑑𝑥0

𝑑𝑡
= 𝑘′(𝑇)  For non-adherent materials 

And 

𝑘′(𝑇) = 𝐴𝑤𝑒
−

𝐸𝑎
𝑘𝐵𝑇 

With 𝐴𝑤(𝑇) 𝑒𝑡
𝐸𝑎

𝑘𝐵
(𝑇) defined by the parameters Aw and Ea_kB of the material in the 

configuration file. 
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The mass flow or ablation produced for non-adherent materials only is: 

 

�̇�𝑜𝑏 = −
1

1 +
𝜂𝑂
𝜂𝑀

𝑥𝑀
𝑀𝑂
𝑀𝑀

𝜌0

𝑑𝑥0

𝑑𝑡
 𝑆𝑒𝑥𝑝𝑜𝑠𝑒𝑑 = 𝑘𝑜𝑥𝑀𝑎𝑠𝑠𝐹𝑙𝑜𝑤𝑅𝑎𝑡𝑒

𝑑𝑥0

𝑑𝑡
 𝑆𝑒𝑥𝑝𝑜𝑠𝑒𝑑 

7.10 Survivability parameter 

The survivability parameter is computed as follows: 

< 𝑠𝑢𝑟𝑣𝑖𝑣𝑎𝑏𝑖𝑙𝑖𝑡𝑦𝑃𝑎𝑟𝑎𝑚𝑒𝑡𝑒𝑟 > =
< 𝑑𝑒𝑚𝑖𝑠𝑒𝐴𝑙𝑡𝑖𝑡𝑢𝑑𝑒 >

< 𝑐𝑟𝑒𝑎𝑡𝑖𝑜𝑛𝐴𝑙𝑡𝑖𝑡𝑢𝑑𝑒 >
− 

< 𝑓𝑖𝑛𝑎𝑙𝑇ℎ𝑒𝑟𝑚𝑎𝑙𝑀𝑎𝑠𝑠 >

< 𝑖𝑛𝑖𝑡𝑖𝑎𝑙𝑇ℎ𝑒𝑟𝑚𝑎𝑙𝑀𝑎𝑠𝑠 >
 

 

7.11 Normal shutdown 

To shut down the DEBRISK software, use the “Quit” function in the main menu, accessible in the 

top left-hand corner. 

 

Figure 65 Closing the software. 

If the results of any of the simulations defined have not been saved, a warning pop-up is displayed 

to the operator. 



 

 

CNES 
 

DEBRISK 

 
Ref. DBK-MU-LOG-0268-GMV 

Date 22/05/2023 

Version 2.19 Page:  84/114 

 

 GMV  
17, rue Hermès 

Parc Technologique du Canal 
31520 Ramonville-St-Agne 

 

 

Figure 66 Simulation not saved warning pop-up 

8  Error situation 

Section 9.3 describes the possible error messages in DEBRISK according to their location or 

reason for being displayed, as well as the procedure to be applied in these cases. 

8.1 Recovery procedures 

Similarly, section 9.3 describes the possible error messages in DEBRISK according to their 

location or reason for being displayed, as well as the procedure to be applied in these cases. 

8.2 Java Virtual Machine (JVM) memory management 

 The maximum memory size that the JVM allows DEBRISK will depend on several issues, 

mostly on the operating system (OS). 

 In particular, on Windows 32 bits, the JVM limits the maximum memory size for DEBRIK to 

about 300 Megabytes. When this limit is reached, the garbage collector is triggered in order to try 

to free some memory, and the DEBRISK application is slowed down. 

 It’s somehow possible to handle the JVM in terms of memory allocation, via the following 

parameters: 

 -Xmx<size>: It allows defining the maximum memory size of the JVM. 

 -Xms<size>: It allows defining the memory size that will be allocated on JVM start. 

 The size is defined with a value and the units. For instance, to launch DEBRISK on a 

Windows 32 bits machine with a memory size of one Gygabyte, the command line would be: 

 java –Xmx1024m –Xms1024m –jar debrisk.jar 
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 It’s recommended to use the same value for the initially allocated memory (-Xms) and the 

maximum memory size (-Xmx). A minimum value of 1024m for both parameters is recommended 

when running on a Windows 32 bits architecture. 

 For further information on the management of memory by the JVM, please refer to the 

following link: http://docs.oracle.com/cd/E19563-01/819-4438/gavou/index.html 

In order to monitor the current memory consumption, a dedicated area (called “Memory”) has 

been included in the top for the main DEBRIK window. It is displayed in green when the 

consumed memory is below 75% of the available memory, in red if it is above 90% and orange 

otherwise. 

  

http://docs.oracle.com/cd/E19563-01/819-4438/gavou/index.html
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When passing the mouse over this area, dedicated information is shown: 

 

Figure 67 Memory monitor 

Information included in this area includes: 

- Used Memory (%): percentage defining the used memory with respect to the maximum 

available one 

- Maximum Memory: it is the maximum quantity of memory to be dedicated to the current 

process 

- Allocated Memory: it is the memory that has been allocated by the program in current run 

- Used Memory: it is the real memory currently being used  

- Free Memory: it is the current free memory (difference between the allocated and the used 

memory) 
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9 Reference manual 

9.1  Introduction 

Keyboard shortcuts in the main window can be used to access the different 

DEBRISK menus/options: 

- ALT + F: pulls down the “File” menu 

- CTRL + N: execution of the “New” menu 

- CTRL + O: execution of the “Open” menu 

- CTRL + S: execution of the “Save” menu 

- CTRL + Q: execution of the “Quit” menu 

- ALT + H: pulls down the “Help” menu 

- F1: execution of the “Help-> Show help” menu 

- CTRL + A: execution of the “Help->About” menu 

- CTRL + W: closing of the active simulation tab 

The following commands can be used in the window panes or forms: 

- TAB: used to move from one field to the next 

- Enter: is used to validate the form 

- Esc: is used to close the current window pane 

- F1: is used to display Help. 

9.2  Definitions and operation of the monitor 

The station must be equipped with a monitor with minimum resolution of 1280x1024. 

9.3 Plate ablation 
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The ablation of the plate will be realised modifying the length and width of the plate but 

maintaining its thickness. 

9.4 Error messages 

If the input parameters are not conforming to the use of the software, an error message is displayed. 

Input parameters are expected in the following cases: 

• Entry of initial conditions 

• Creation of objects 

• Creation of a new material 

• Reading of an input file 

In addition, messages of the “operation” type can also be displayed. 

9.4.1 Error messages when entering the initial conditions 

When a field is not correct, the following message is displayed:  

Error in one of the input fields: <errorMessage> 

<errorMessage> can be: 

o The initial date is not correct 

o Fragmentation altitude should be between 70 km and 100km 

o The eccentricity cannot be negative 

o Inclination angle should be between 0° and 180° 

o Impossible to create Orbit with these values 

9.4.2 Error messages when creating an object  

The creation of objects must be done according to certain rules (see chapter 7.5.1.3). 

Failure to comply with these rules causes an error message in the input window as shown below: 
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Figure 68 Error message 

These messages are either generic (independent of the shape of the object): 

o “Object name shall not contain ‘#’” 

o “The volume cannot be negative” 

o “The mass should be > 1e-10.” 

o “Invalid values found! <VALUES>." 

This message means that the properties of the object are not physical. Here <VALUES> indicates 

the properties of the object so that the user can make the correction. 

  



 

 

CNES 
 

DEBRISK 

 
Ref. DBK-MU-LOG-0268-GMV 

Date 22/05/2023 

Version 2.19 Page:  90/114 

 

 GMV  
17, rue Hermès 

Parc Technologique du Canal 
31520 Ramonville-St-Agne 

 

Depending on the shape of the object: 

• Sphere: 

o  “The inner radius cannot be negative.” 

o "The outer radius cannot be negative." 

o "The inner radius cannot be larger than 100m." 

o "The outer radius cannot be larger than 100m." 

o "The outer radius cannot be smaller than inner radius" 

o "The mass cannot be negative" 

o "The thickness cannot be negative" 

o "Resulting inner radius (<VALUE>) cannot be negative" 

o "Resulting outer radius (%s) cannot be larger than 100m" 

o "The mass cannot be greater that the equivalent solid sphere (<VALUE> > 

<VALUE>).” 
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•  Cylinder: 

o "The inner radius cannot be negative." 

o "The outer radius cannot be negative." 

o "The outer length cannot be negative." 

o "The inner radius cannot be larger than 100m." 

o "The outer radius cannot be larger than 100m." 

o "The outer length cannot be larger than 100m." 

o "The outer radius cannot be smaller than inner radius" 

o "The thickness cannot be negative" 

o "The mass cannot be negative" 

o "Resulting inner radius (<VALUE>) cannot be negative" 

o "Resulting thickness (<VALUE>) cannot be negative" 

o "The mass cannot be greater that the equivalent solid cylinder (<VALUE> > 

<VALUE>).” 

o "The outer length should be larger than twice the thickness" 
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•  Box: 

o "The length should be larger than the width." 

o "The width should be larger than the height." 

o "The height should be larger than twice the thickness." 

o "The width cannot be negative." 

o "The mass cannot be negative" 

o "The thickness cannot be negative" 

o "The length cannot be negative." 

o "The height cannot be negative." 

o "The length cannot be larger than 100m." 

o "The width cannot be larger than 100m." 

o "The height cannot be larger than 100m." 

o "The mass cannot be greater that the equivalent solid box (<VALUE> > 

<VALUE>)." 

• Plate 

o "The width cannot be negative." 

o "The length cannot be negative." 

o "The thickness cannot be negative" 

o "The mass cannot be negative" 

o "The width cannot be larger than 100m." 

o "The length cannot be larger than 100m." 

o "The length should be larger than the width." 

o "The thickness cannot be larger than 10% of the width. Please use a box instead." 
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• Complex 

o "The minor diameter cannot be negative" 

o "The major diameter cannot be negative" 

o "The height cannot be negative" 

o "The thickness (<VALUE> m) shall be less than 10.0% of the apothem 

(<VALUE> m)" 

o "The thickness cannot be larger than 100.0 mm" 

o "The mass (<VALUE> kg) cannot be negative"; 

o "The height (<VALUE> m) cannot be larger than 100.0 m" 

o "The minor diameter cannot be larger than 100.0 m" 

o "The major diameter cannot be larger than 100.0 m" 

o "The volume (<VALUE> m3) shall be larger than 0 for complex shape” 

o "The angle (<VALUE> deg) shall be larger than 0" 

o "The angle (<VALUE> deg) cannot exceed 360.0 deg" 

o "The flatness (<VALUE>) shall be either 1 or 2 " 

o " The major diameter (<VALUE> m) cannot be smaller than the minor diameter 

(<VALUE> m)” 

• Complex spherical 

o "The combination of the small diameter and thickness is such that the internal 

minor diameter is negative" 

o "h > sqrt(large_radius^2 - small_radius^2) (<VALUE> > <VALUE>) [m] " 

• Complex conical 

o "The combination of the small diameter and thickness is such that the internal 

minor diameter is negative (<VALUE> m)" 
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• Tube 

o "The outer radius cannot be negative" 

o "The inner radius cannot be negative" 

o "The outer length cannot be negative" 

o "The outer radius cannot be larger than 1000000.0 m" 

o "The inner radius cannot be larger than 1000000.0 m" 

o "The outer length cannot be larger than 1000000.0 m" 

o "The outer radius cannot be smaller than inner radius" 
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9.4.3 Error messages when creating a new material 

 

Figure 69 Entry of a user-defined material 

If a mandatory field is not filled in, an error message is displayed: 

“The following errors occurred: 

<MSG> 

You’ll have to correct the errors before you can continue.” 

<MSG> can be: 

o “A name should be specified” 

o “This name already exists” 

o “The density is not valid” 

o “The melting temperature is not valid” 

o “The heat of fusion is not valid” 
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o “The oxide heat of formation is not valid” 

o “The emissivity is not valid” 

o “The heat capacity is not valid” 

If a negative emissivity or heat capacity is introduced by the user, the following error occurs: 

“<MSG> Material Emissivity is not positive in all the temperature range.” 

If a negative heat capacity is introduced by the user, the following error is obtained: 

“<MSG> Material Heat Capacity is not positive in all temperature range.” 

9.4.4  Error messages when reading an input file 

If the format of the input file is not the expected format, an error message is displayed. 

“<MSG> Check the log file for more details”. 

<MSG> depends on the exception type. The possible exceptions and the corresponding message are 

listed below: 

o CVSFileException: “Error reading/writing CSV file: <ERROR> (<file_path>)” 

o InvalidDasFileException: “This is not a valid DAS file (<file_path>). Operation aborted.” 

o InvalidDebriskDirectoryException: “The installation directory does not contain the 

necessary files. Please check the installation files and restart. Debrisk will quit now.” 

o InvalidUserMaterialFileException: “The user defined materials file is not valid 

(<file_path>). Operation aborted.” 

o InvalidXMLFileException: “This is not a valid Debrisk XML file (<file_path>). Operation 

aborted.” 

o KMLFileException: “Error reading/writing KML file: <ERROR> (<file_path>)” 

o OrekitConversionException: “Cartesian conversion error. Operation aborted.” 

o OrekitNotInitializedException: “Orekit not initialised. Operation aborted.” 

o TecplotFileException: “Error reading/writing Tecplot file: <ERROR> (<file_path>)” 

o XMLFileException: “Error reading/writing xml file: <ERROR> (<file_path>)” 

o ZipFileException: “Error reading/writing zip file: <ERROR> (<file_path>)” 
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9.4.5 Operation error messages 

• If the simulation exceeds 1000000 seconds, the following message is displayed: 

“Simulation took more than the max duration (xxx s).” 

• During an export, if the output file already exists but is not accessible (rights), the user is warned 

by the following message: 

“The file to write to already exists but it cannot be deleted. Please check the permissions on this file 

and try again.” 

• When an attempt is made to import a simulation when the current tab already contains data, the 

following message is displayed, and the simulation is loaded in a new tab: 

“Current tab already contains data; data will be stored in new tab.” 

• If the user tries to add an object at the root of the tree when a spacecraft already exists (there can 

only be one spacecraft), the following message is displayed: 

“You can’t add a spacecraft: please first select the spacecraft item in object list if you want to add 

children or edit the current spacecraft.” 

• If a simulation loaded from a file contains unknown materials, the following message is displayed: 

“Cannot create material of type <MATERIAL_TYPE>.  

Properties will be taken from titanium.” 

• When loading a DAS file, the following message may be displayed if certain materials are not 

recognised: 

“DAS file contains n entries. 

<NB> unknown materials found. 

Please check your table for unknown materials, 

They currently have the same thermal properties as Titanium.” 

• When a problem is detected during the propagation of an object, this object is shaded in the interface 

and the user is warned by the following message at the end of the simulation: 

“The computation has ended but n object(s) could not be computed correctly. 

These objects are indicated in grey.”  

Here, “n” indicates the number of objects in error. 

To find out the details of the errors, the user must do an XML export (“save” option) and look up 

the file generated. This contains, for each calculated object (“<object>” tag), a “results” tag 

containing the calculation results for this object. Inside, a “<stopReason>” tag gives a description 

of the error which caused the simulation of this object to stop. 

 

Errors of the “abnormal” type may also occur: 
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• If the user presses F1 to display Help and the user’s manual has not been found in the DEBRISK 

installation directory, the following message is displayed: 

“The document DBK-MU-LOG-0268-GMV.pdf could not be found. (Help unavailable)” 

• If the files required for the operation of DEBRISK, and usually located in the directory containing 

the DEBRISK executable file, are not found, the following message is displayed: 

“The installation files have not been found. 

Those files should be in the directory where the debrisk.jar is installed. 

In your case this is <installationDirectory> 

For the current execution only, you'll be asked to select the directory where the installation files are 

located.” 

 

Messages of the “internal” type may also be displayed: They start with “Internal error” and indicate a 

malfunction of the application (case not managed by the application). 

 

Confirmation messages can also be displayed if the program has to delete or replace an existing file. 
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9.5 3D View configuration 

The 3D view configuration colours can be configured by the user through the dirPath.properties 

file that is located in the installation directory after loading or saving a configuration. 

The 3D view is activated by default, if the program does not work correctly using the 3D 

view (graphic card problem, etc) the 3D view can be deactivated manually by editing the 

dirPath.properties manually and setting the value of the property isUse3DActivated to 

false. 

The following values can be modified to configure the 3D view: 

 

Key Value Range 

isUse3DActivated Selects if the 3D View is active [true, false] 

view3D.backgroundRed Background red channel value [0.0, 1.0] 

view3D.backgroundGreen Background green channel value [0.0, 1.0] 

view3D.backgroundBlue Background blue channel value [0.0, 1.0] 

view3D.outerSurfaceRed Shape’s outer surface red channel [0.0, 1.0] 

view3D.outerSurfaceGreen Shape’s outer surface green channel [0.0, 1.0] 

view3D.outerSurfaceBlue Shape’s outer surface blue channel [0.0, 1.0] 

view3D.outerSurfaceAlpha Shape’s outer surface alpha channel [0.0, 1.0] 

view3D.innerSurfaceRed Shape’s inner surface red channel [0.0, 1.0] 

view3D.innerSurfaceGreen Shape’s inner surface green channel [0.0, 1.0] 

view3D.innerSurfaceBlue Shape’s inner surface blue channel [0.0, 1.0] 

view3D.innerSurfaceAlpha Shape’s inner surface alpha channel [0.0, 1.0] 

view3D.borderSurfaceRed Shape’s border surface red channel [0.0, 1.0] 

view3D.borderSurfaceGreen Shape’s border surface green channel [0.0, 1.0] 

view3D.borderSurfaceBlue Shape’s border surface blue channel [0.0, 1.0] 

view3D.borderSurfaceAlpha Shape’s border surface alpha channel [0.0, 1.0] 

view3D.complexBorderSurfaceRed Complex shape’s border surface red channel [0.0, 1.0] 

view3D.complexBorderSurfaceGreen Complex shape’s border surface green channel [0.0, 1.0] 

view3D.complexBorderSurfaceBlue Complex shape’s border surface blue channel [0.0, 1.0] 

view3D.complexBorderSurfaceAlpha Complex shape’s border surface alpha channel [0.0, 1.0] 

 

The other values in the dirPath.properties file are managed internally by DEBRISK and shall not 

be modified. 
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10 Tutorial 

10.1  Introduction 

The purpose of this part is describing briefly the general operation of DEBRISK; it proposes a 

typical case of object creation and the creation of result files. 

10.2  Starting up 

 

Figure 70 Menu 

 

The following functions can be accessed from the File menu, in the top left-hand corner of the 

screen: 

“New”: this creates a new tab in which you can create or open a new case to be studied. 

“Open”: is used to open a previously saved study case. 

“Export”: is used to export files to other software packages (Tecplot, Google Earth, CSV). 

The Tecplot, Google Earth and CSV files will be encoded following the UTF-8 format. 

Hence, in order to be able to read it properly, you must use a text editor compatible with 

UTF-8 (such as notepad++, for instance). 

If we want to import the file in Excel or any other program, you must indicate during this 

process that the file is encoded in UTF-8 format. The parameters contained in these files are detailed 

below: 
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- CSV file 

The CSV file contains a header with the name, date of creation, version of DEBRISK and mode (SCI or 

LOS). This header is then followed by the data: 

 

Parameter Units 

Parent id  -- 

Id  -- 

Name  -- 

Quantity  -- 

Shape  -- 

Material  -- 

Initial altitude(m) m 

Initial mass(kg) kg 

Rout/Height(m) m 

Rin/Width/Rsmall(m) m 

Length/Rlarge(m) m 

Thickness(m) m 

Angle(deg) deg 

Cb_intial(kg/m2) kg/m2 

Stop reason  -- 

Demise altitude(m) m 

Impact mass(kg) kg 

Final Rout/Height(m) m 

Final Rin/Width/Rsmall(m) m 

Final Length/Rlarge(m) m 

Final Thickness(m) m 

Final angle(deg) deg 

Cb_onGround(kg/m2) kg/m2 

Impact energy(J) J 

Cross section area(m2) m2 

Total casualty area(m2) m2 
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Parameter Units 

Weighted casualty area(m2) m2 

Initial CCond(W/K) W/K 

Final CCond(W/K) W/K 

End temperature(K) K 

Max temperature(K) K 

 

- Tecplot file  

The first lines of the Tecplot contain the name, date of creation, version of DEBRISK and mode (SCI or 

LOS). Then, the Tecplot files contains the following data: 

 

Parameter Units 

time(s) s 

altitude(m) m 

longitude(deg) deg 

latitude(deg) deg 

azimuth(deg) deg 

velocity(m/s) m/s 

velocityInertial(m/s) m/s 

acceleration(m/s2) m/s2 

flowRate(kg/s) kg/s 

downRange(km) km 

localDownRange(km) km 

downRangeShortest(km) km 

FPA(deg) deg 

extTemperature(K) K 

extDensity(kg/m3) kg/m3 

extPressure(Pa) Pa 

Mach  -- 
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Parameter Units 

Knudsen  -- 

aerodynamicMass(kg) kg 

thermalMass(kg) kg 

kineticEnergy(J) J 

referenceAeroArea(m2) m2 

referenceThermalArea(m2) m2 

radiationArea(m2) m2 

outerArea(m2) m2 

wallTemperature(K) K 

Cd  -- 

dragForce(N) M 

ballisticCoefficient(kg/m2) kg/m2 

QconvColdWall(W/m2) W/m2 

Qconv(W/m2) W/m2 

Qoxidation(W/m2) W/m2 

QradGain(W/m2) W/m2 

QradLoss(W/m2) W/m2 

Qcond(W) W 

Qnet(W/m2) W/m2 

“Save": is used to save the case being studied by including the list of objects and the initial 

conditions. 

“Save As”: is unsed to save the case being studied under another name. 

“Quit”: is used to close the software. 
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Entry conditions: 

 

Figure 71 Entry conditions 
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10.2.1 Scenario area 

You will find various tabs in this area. The first one, named “Entry conditions”, must be filled in 

with the general parameters of the entry point corresponding to the kinematic conditions of the 

spacecraft to be studied. The parameters to be entered are the parameters of the Keplerian orbit of 

the spacecraft object. 

 

10.2.1.1 Object tab 

The object tab allows you to add new objects using the Add button, to edit some objects already 

created using the Edit button, to duplicate objects using the Duplicate button or to delete others 

using the Delete button.  

When clicking on “Duplicate”, the whole group of children, grandchildren… of the selected object 

will also be duplicated.  

In the left part, you can see a tree representing the overall structure of the case you are about to 

simulate. The indentation of the elements in this tree shows the parent-child links existing between 

the different objects. 

To add an object, select a parent object in the tree or the table and click on the Add button. A new 

window is displayed. 

  

Figure 72 Creating an object. 
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In this window, you are asked to enter the following elements: 

• object name 

• Relationship. This parameter allows to define if the new object is a standard “child” or a 

“component” of the parent object. 

• Quantity of fragments. This parameter is used when the operator wants to define several 

fragments with the exact same characteristics. Even if Q>1, a single simulation will be run 

for the fragment. This value will only be used to compute the aerodynamic mass of an object 

having children with Q/=1 and for the casualty area (which will be computed as the casualty 

area of the simulated fragment multiplied by Q). 

• selection of the object shape 

• selection of the mode for entry of the dimensions of the object according to the data at your 

disposal. All the other data will be calculated by DEBRISK so that they correspond to the 

data provided by the user. 

• The material of the object to be selected in the list. 

• Dimensions to be complemented according to the mode selected beforehand. 

• Conduction coefficient. 

Please note that the first object in the list is always a spacecraft, while the others are always 

fragments. 

Solar panels can be added on the space object, modelled only by a box, a cylinder or a sphere, using 

the “solar panels” button, which is only displayed on the window for this object. 
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10.2.1.2 Materials tab 

In the materials tab, you will find the properties of the various materials used in the simulation. This 

includes the following parameters for each material: 

• density in kg/m3 

• heat of fusion in J/kg 

• melting temperature in K 

• oxidation heat in J/kg (O2) 

 

10.2.1.3 Viewing area 

The viewing area is in the right part of the interface. It is used to analyse the evolutions of the 

various parameters during the simulation. The results are presented in five types of predefined 

graphs: 

• altitude vs. time 

• thermal mass vs. time 

• thermal mass vs. altitude 

• altitude vs. downrange 

• temperature vs. time 

In the table on the left, the columns have been modified to present a summary of the state at the end 

of the simulation for each object. We then find: 

• the quantity of fragments 

• the object destruction altitude: the cell is coloured in red if the object is not destroyed, and 

in green if it does not reach the ground. In case of error during the calculation, this cell is 

shaded (see §9.3). 

• the energy on impact: the cell is coloured in red if the energy on impact is higher than 14J, 

in yellow if it is lower or equal, or in green if the object does not reach the ground. In case 

of error during the calculation, this cell is shaded (see §9.3). 
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• the casualty area in the case of an object which reaches the ground (sum of all the fragments 

if the quantity is > 1). 

• The initial aerodynamic mass 

• the final aerodynamic mass 

• the percentage of aerodynamic mass left 

• maximum surface used for the calculation of the casualty area 

• the maximum temperature 

• the final temperature 

The user can switch between the views of the object panel (before/after execution) by clicking on the 

“Swap” button.  

 

  

Figure 73 Swap objects table view 
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Below the objects table we will find an entry where the total casualty area (corresponding to the 

addition of the casualty area of all the fragments) will be displayed, the value will only be displayed 

when an execution has been done and removed when the simulation is reset: 

  

Figure 74: Total casualty area value after an execution. 

10.3 Using the software for a typical task 

10.3.1 Creation of a simulation and result files 

From the File menu, in the top left-hand corner of the screen, click on the “New” tab: this creates a 

new tab in which you can create or open a new case to be studied. 

  

Figure 75 Menu 

You will find various tabs in this area. The first one, named “Entry conditions”, must be filled in 

with the general parameters of the entry point corresponding to the kinematic conditions of the 

spacecraft to be studied. The parameters to be entered are the parameters of the Keplerian orbit of 

the spacecraft object. 
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Figure 76 Entry conditions 
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Click on the object tab, and then on the Add button; a new window is displayed: 

 

Figure 77 Creating a spacecraft. 

 

• Enter the outer radius, for example 1m. 

• Enter the thickness of the cylinder, for example 1mm  

• Enter the length, for example 2m 

• Enter the aerodynamic mass, for example 1000kg 
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Press “apply”, and then again on the object tab, and on the Add button to create a child object. 

  

Figure 78 Creating a child object. 

 

• Enter the outer radius, for example 1m. 

• Enter the inner radius, for example 0.5m. 
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Then press “apply” 

 

 

Figure 79 Results and viewing area. 

 

Press “Run” to launch the simulation; you will see a graph displayed in the right part of the 

screen. 

To save the simulation, different formats are available (Flat XML, Tecplot, Kml, CSV). To 

create one of these files, click on the File menu in the top left hand corner of the screen, click 

on the “Export” tab and select the desired format. It is possible to save all files at once by 

clicking on the “Zip” tab.  

 

 

Name the file, then using the drop-down menu, choose the folder where you want to save the 

file. Note that the folder proposed by default is the last one used in DEBRISK. 

Press “Save” to save the file in the folder you have chosen. 

During the export of the file, the following pop-up will be displayed (a similar pop-up window 

is shown whatever the exported file is): 

 

Figure 80 Export file pop-up 
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The flatXML, KML and XML file will be encoded following the UTF-8 format. Hence, 

in order to be able to read it properly, you must use a text editor compatible with UTF-8 

(such as notepad++, for instance). 

If we want to import the file in Excel, you must indicate during this process that the file is 

encoded in UTF-8 format. 
 

 

Figure 81 Importing a file encoded following the UTF-8 format in Excel 


